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Abstract 
For a teacher, an effective and successful lesson plan is the one that can help students not only 

master their knowledge, create new skills but also develop their own interest in learning. 

Therefore, teachers must always invest a lot of their time and effort in building interesting lesson 

plans. One of the ways of creating such lesson plans is using games in teaching process. Thanks to 

multimedia, teachers themselves can design competitive and challenging games that make students 

feel fun when engaging in their learning activities. As such, “Building classroom games via 

multimedia” has been chosen as the topic for this paper. This paper aims at presenting some useful 

sources of materials especially from the internet that teachers can use for reference when preparing 

their lessons. Then, it shows the flexible combination of multimedia in class. Finally, it makes 

productions of some techniques in using multimedia through PowerPoint such as using Macros, 

Visual Basic Editor etc. We believe that the findings of this paper can bring positive effects in 

teaching and learning English. 
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1. Introduction 

According to Ur (1988), the actual language production is in hands of the learners, the teachers merely 

providing instructions and materials and acting as a monitor and helper. It means that learners need to 

participate actively in class; in other word, it is active learning. When we discuss active learning in the 

classroom, it is understood that lecture is still important – the foundational knowledge required for 

students to be able to engage in higher level thinking is essential. However, for the sake of maintaining 

student interest, and facilitating meaningful, and eventually self-directed learning, it can be very helpful 

to vary the teaching and learning activities you employ in the classroom (cited from CELT Teaching Tip 

Sheet, p.1). There are a wide range of activities used both inside and outside the classroom that promote 

active learning and one of them is using games. Furthermore, nowadays, with the aids of multimedia, it 

seems easier for teachers to create effective activities in order to make learning fun and interesting both 

for the learners and teachers. As such, in this paper we will deal with the factor of building classroom 

games via multimedia so that it can support teachers in their language teaching.  

 

2. Roles Of Classroom Games In Language Teaching 

In the introduction of the book “Games for Language Learning”, Andrew Wright, David Betteridge and 

Michael Buckby (1984) states that language learning is hard work. One must make an effort to 

understand, to repeat accurately, to adapt and to use newly understood language in conversation and in 

written composition. Effort is required at every moment and must be maintained over a long period of 

time. Games help and encourage many learners to sustain their interest and work.  In addition, Wright et 

al also affirm that games also help the teacher to create contexts in which the language is useful and 

meaningful. Games provide one way of helping the learners to experience language rather than merely 

study it.  

 

Moreover, Lee Su Kim, writing in Forum journal in 1995, sums up the perception that the classroom is 

considered by many to be no place for games. These ones think that all learning should be serious and 
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solemn in nature, and that if one is having fun and there is hilarity and laughter, then it is not really 

learning. However, Su Kim asserts that this is a misconception. He states it is possible to learn a language 

as well as enjoy oneself at the same time. One of the best ways of doing this is through games. 

Furthermore, he reasserts the points: there are many advantages of using games in the classroom: 

 Games are a welcome break from the usual routine of the language class. They are 

motivating and challenging. 

 Learning a language requires a great deal of effort. Games help students to make and sustain 

the effort of learning. 

 Games provide language practice in the various skills- speaking, writing, listening and 

reading. 

 They encourage students to interact and communicate. 

 They create a meaningful context for use. 

 

In short, there is no doubt that using games in class brings a lot of benefits for language learning and 

teaching. Therefore, when teachers prepare language activities for their lessons, games should be taken 

into account. Nevertheless, they should keep in mind that games are used not only for mere fun, but more 

importantly, for the useful practice and review of language lessons, thus leading toward the goal of 

improving learners’ communicative competence. (Nguyen Thi Thanh Huyen and Khuat Thi Thu Nga, 

writing in the Asian EFL Journal in 2003) 

 

3. What is multimedia? 

According to Tannenbaum (1998), “multimedia” is derived from a shortening of the two words “multiple” 

and “media”.  In addition, Alan Cutting (2011) asserts that the term “media” have been long used in the 

field of education. However, it sometimes only referred to “audio-visual aids”, to help our teaching.. 

Also, Fenrich (1997) defines that multimedia is the exciting combination of computer hardware and 

software that allows you to integrate video, animation, audio, graphics, and test resources to develop 

effective presentations on an affordable desktop computer. As a result, when concerning about using 

multimedia to build classroom games, this paper will focus on using applications of computer software 

especially Microsoft PowerPoint to achieve this. 

 

4. Building classroom games via multimedia 

4.1. Preparation for building games 

First of all, it is really important for teachers to determine the stages of the lesson in which games will be 

used. They just need a warm-up game – game used to activate students at the beginning of the class, a 

practicing game- game used after each part of the lessons, or a lesson game – game used together with the 

lesson being taught. When keeping this in mind, they can choose suitable games for their lessons. The 

next step is that teachers need to gather all the materials related to their lesson. It is essential that teachers 

equip themselves with variety of materials. Materials can be taken from textbooks, from reference books 

or from the internet. Last but not least, how to tie all these materials together to make a fun game should 

be taken into account.  

 

4.1.1. Useful sources of materials 

Apart from the materials teachers can take from the textbooks, teacher’s books, from the school library; 

there is the internet, this is, without a doubt, the biggest resource of all, and is capable of providing a 

wealth of learning experiences to all students. With only Google search tool, teachers can catch a huge 

source of materials such as video files, audio files, word files, portable files, picture files etc. Therefore, in 

this part of the paper, there will be the introduction of useful books and websites which teachers can use 

as reference materials. 
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First, there are some good game books which help teachers to have the ideas for building games.  

 

1. Fun with Grammar, Communicative Activities for the Azar Grammar Series by Suzanne W. 

Woodward, Prentice Hall Regents, 1997. 

2. “Games for Language Learning” by Andrew Wright, David Betteridge, Michael Buckby, 

Cambridge University Press, 2006.  

3. “Grammar Games, Cognitive, Affective and Drama Activities for EFL Students” by Mario 

Rinvolucri, Cambridge University Press, 1998. 

4. “Great Ideas, Listening and Speaking Activities for Students of American English, Teacher’s 

Manual” by Leo Jones & Victoria Kimbrough, Cambridge University Press, 1987. 

5. “Ready-made English, Multi-level Activities” by Kurt Scheibner, Heinemann Publishers 

(Oxford) Ltd, 1995. 

6. “Reward, Resource Pack, Communicative Activities for Students of English” by Susan Kay, 

Macmillan Publishers Limited, 1998. (Five levels) 

7. “Speaking Extra, A Resource Book of Multi-level Skills Activities” by Mick Gammidge, 

Cambridge University Press, 2004. 

8. “The Great Big Book of Games and Puzzles” compiled by Anna Amari-Parker and edited by 

Rebecca Gerlings, Arcturus Publishing Limited, 2006. 

9. “Word Games with English, Teacher’s Resource Book” by Deirdre Howard Williams & 

Cynthia Herd, Macmillan Publishers Limited, 1998. 

10. “Zero Prep, Ready-to-Go Activities for the Language Classroom” by Laurel Pollard and 

Natalie Hess, Alta Book Center Publishers- San Francisco, 1997. 

 

The above books contain interesting games as well as interactive activities that can not only help students 

to practice different skills such as speaking skills, listening skills, reading skills and writing skills but also 

make them sustain the interest in their learning. There are many other game books, but as for me, these 

above books are easy to use and applicable to various kinds of lessons with different levels of students. 

 

Second, some useful websites that provide printable and interactive games and activities are listed below 

so that teachers can use as sub-materials for their lessons. 

 

1. http://www.michellehenry.fr/default.htm 

2. As for me this is one of the best sites for ESL materials and this link is for the huge collection 

of games and other links. Busy teachers can find various multimedia with different topics that 

they can choose for their lessons.  

3. http://www.esl-lab.com 

4. This is a wonderful site for listening practice, teachers can choose any topics they like with 

different levels. 

5. http://www.eslbase.com 

6. This site has a lot of free, downloadable, ready-to-use activities, lesson plans, ideas and 

worksheets for your classes. 

7. http://bogglesworldesl.com 

8. This site contains printable teaching resources for language arts, TESOL, TEFL and ESL. 

9. http://baladre.info/english/sedaviwebfront/index.htm 

10. This site is a very easy way to refresh structures and exercises seen in class. It also has many 

listening exercises, some with interesting songs. 

11. http://www.eslprintables.com 

12. This website is the place where English language teachers exchange resources: worksheets, 

lesson plans, activities, etc. Their collection is growing every day with the help of many 

teachers. Teachers can find useful worksheets or PowerPoint lessons available for their lesson 

plans. If they want to download they have to send their own contributions. It means that in 

http://www.michellehenry.fr/default.htm
http://www.esl-lab.com/
http://www.eslbase.com/
http://bogglesworldesl.com/
http://baladre.info/english/sedaviwebfront/index.htm
http://www.eslprintables.com/
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order to download available files, teachers have to upload their own files to get the points. 

The more people download your files, the more points you can get.  

13.   http://www.isabelperez.com/songs.htm 

14. This site contains a list of songs with related activities to practise vocabulary, grammar, 

sounds, etc. Most of them are popular and some others are old songs, but nice and useful. The 

students can feel fun and relaxed when practicing English with songs. 

15. http://www.eslcafe.com/idea/index.cgi?Games 

16. This is a well-known excellent site that offers alphabetically listed games and how to play 

them. Besides, it also has a forum where teachers can find and share ideas for teaching. 

17. http://www.eslflow.com/games1.html 

18. This is a must visit site as it has a superb collection of games and downloadable activities for 

most occasions. 

19. http://www.esl-galaxy.com/lessons.htm 

20. This is an excellent site with games for all levels. It offers over 2368 free printable 

worksheets for ESL lesson plans and ESL activities; and there are more additions every other 

day. 

 

4.1.2. Choosing suitable types of multimedia used in each lesson 

Choosing suitable types of multimedia used in each lesson is a very important step for teachers themselves 

because this is the key to effective teaching and a critical factor in achieving positive student outcomes. 

Therefore, teachers should pay much attention to selecting applicable multimedia. They should bear in 

mind if they need to use any movies, videos, audio files, flash files, graphics, animations or they just need 

a worksheet, or even with only a chalk and a blackboard to build a classroom game or they need to 

combine all of them. With the reference books and websites recommended above, I think that they will 

find it easy to create a good game for their class. 

 

4.2. Flexible combination of various multimedia 

4.2.1. Using available worksheets and board games in game books and from the internet 

As suggested above, there are a wide range of reference materials available on the internet and in 

activities’ books that teachers can be ready to use in their lessons. These are printable worksheets and 

board games. It is to say that teachers can make some copies or print them out.  

 

4.2.2. Using slides in PowerPoint 

Using slides in PowerPoint file is a time – saving, visual and interesting way to build a game. Teachers 

can combine multimedia effectively and flexibly. They can insert video files, audio files, flash files, 

pictures or charts etc. in a PowerPoint file.  

 

a. Using simple and available animations in PowerPoint to have a beautiful and useful slide 

In order to review the previous lesson, teacher can use a definition game. In this game, teachers can check 

students’ vocabularies which they learned from previous lesson. One member in each group has to define 

the word and the rest of his or her group has to guess the correct word. The more words they can guess, 

the more points they can get. 

http://www.isabelperez.com/songs.htm
http://www.eslcafe.com/idea/index.cgi?Games
http://www.eslflow.com/games1.html
http://www.esl-galaxy.com/lessons.htm
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In order to save the time of designing slides before class and the time used during language lessons, 

teachers can design simple slides by making some copies of one or more shapes and animations. It means 

that they just need to make some basic shapes, add animations for these shapes and then make copies. 

 

b. Using some more complex functions in PowerPoint to make games more interesting 

Apart from simple slides, teachers sometimes also need to make more elaborate ones in order that their 

slides can fulfill more functions, look more beautiful and especially can be useful for language lessons. 

For example: when teachers would like to create a warm-up game both to review the previous lesson and 

to start their new lesson, they can use a guessing game to let students review their knowledge and guess 

the topic of the new lesson. Some macros will be used in these slides to change numbers into letters that 

show the topic of the new lesson, and to set the scores for each team. 

 

 
 

Besides, in order to practice reading skills, a careful design of slides can help students feel more fun and 

relaxed with difficult reading lesson. 

 

 
 

c. Using picture, audio, video and flash files in slides 

Teachers can combine various multimedia in PowerPoint slides to make their games more exciting and 

attractive. Using pictures in slides is a simple and powerful way of getting students’ attention. When 

seeing imaginable, decorative, descriptive, informative, contrastive and attractive pictures, students can 

achieve the goals their teacher wants them to get easily and sometimes feel fun and relaxed with these 

pictures. In addition to using pictures, teachers can also use sounds in their slides. When inserting audio 

files in their slides, they don’t need to use the CD player because it’s ready to use in their slides. 

Furthermore, teachers can take a video from class CD ROM or download from the internet to use in their 

class. When watching the video, students can practice listening skills with real situations. More usefully, 

Flash games downloaded from the internet are ready-to- use activities which save a lot of time for 

teachers. They just need to insert into their slides and ask students to practice the language points they are 

This slide show the example of list of the 

vocabularies a group has to define. 

Each number has a question and each group will choose the 

number they like to answer the question. If they have 

correct answer they get 5 points. Click on the name of each 

group to add their points. (A macro will be run on labels 

Group 1 and Group 2 to set the points for each team. 

Students read the statement and choose “True or False”. 

Click on the number to see the statement. Each group has 5 

sentences. If their answer is correct, their ball will go one 

step. The group getting to the finishing line first wins the 

game. 
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learning. Three of the following flash games are taken from the website: 

http://www.michellehenry.fr/default.htm to help students to practice saying the time. 

 

                 
 

In short, with various multimedia in hand and with the use of them flexibly, teachers can find it easy to 

design interesting, challenging and useful games in their classes.  

 

5. Some techniques in using multimedia through PowerPoint 

5.1. Using audio files 

Audio files are means that are often used in slides. However, teachers sometimes have some problem 

when using these files. One of the frequent trouble is that teachers cannot play the sounds because there is 

no source of these files. This problem is because when making a copy of a PowerPoint file, they don’t 

remember to copy the media files with them. Therefore, the following techniques will help to show this 

problem. 

First, the audio files you need to use in your slides have to change their extension into “*.wav” files 

because only this file type is accepted when using this action. There is some software that can help to 

change the extension of audio files and the software commonly used is GoldWave. You only need to open 

the file that you want to change the extension, then on the File tab, click Save As and choose “*.wav” 

extension. 

 

 

 

 

 

 

 

Second, insert this file into your slide and add action. If you use Microsoft Office PowerPoint 2003, 

choose the shape you need to add an action, then right click on this shape and choose Action Setting. On 

Mouse Click tab, check the box Play sound, select Other Sound then choose the file you need to insert, 

click Ok. 

   
 

From then, whenever and wherever in your file you need to insert this media file, do the same process, 

because at that time, in the Play sound box, this sound is available for you to choose. It means that if you 

http://www.michellehenry.fr/default.htm


AsiaCALL Online Journal (ISSN 1936-9859) 2013 – Special Issue – AsiaCALL2012 Proceedings, Trần Thị Thơm 

 
 

forget to copy the source file, it is not the problem anymore because this sound is always available in this 

PowerPoint file. Furthermore, if you use Microsoft Office PowerPoint 2007, in order to turn on the tab 

Action Setting, choose the shape you need to add an action, then on the Insert tab select Action function, 

the tab Action Setting will appear and do the same process as in Microsoft Office PowerPoint 2003. 

 

 
 

5.2. Using video files 

When inserting a video file directly on a slide, teachers cannot pause at any places of this file. The 

question is how to solve this problem. 

First, you need to display the Developer tab. To do this, click the Microsoft Office Button , and then 

click PowerPoint Options. Click Popular, and then select the Show Developer tab in the Ribbon check 

box. 

Second, on Developer tab, click symbol More Controls  in Controls group, in the list of controls, 

click Window Media Player and then click Ok, after that drag on the slide to draw the control. Next, you 

can resize the Window Media Player on this slide.  

Finally, on Controls group of Developer tab, choose Properties, then on Properties table, copy the path 

of your video file. When viewing Slide Show, you only need to click on Play symbol to play the video. 

 

Moreover, if you use Microsoft Office PowerPoint 2003, in order to display More Controls symbol, in 

View tab select Toolbars, and then choose Control Toolbox. The next steps do the same as in Microsoft 

Office PowerPoint 2007 

 

More importantly, remember to change the path leading to the source files when you make a copy and use 

them on other computers or you cannot see the video at all. However, in order not to do this action, you 

need to use some commands in Visual Basic Editor. At first, on Control toolbox, click the label symbol or 

command button symbol, then change the name and the caption of this label or command button by 

selecting Properties on Control tool box. Second, choose the Window Media Player; click Properties to 

rename the Window Media Player. For example: you change the name of the label into “Label1” and the 

name of the Window Media Player into “WMP”, so the command is as follows: 

 

 

Private Sub Label1_Click() 

WMP.URL = ActivePresentation.Path + "\media\Whattimeisit.mpg" 

End Sub 

 

Remember that the PowerPoint file and the folder containing media files are at the same level. This means 

if the path of the PowerPoint file Time.ppt is “D:\time lesson\time.ppt”, the path of the video file 

Whattimeisit.mpg will be D:\time\lesson\MEDIA\Whattimeisit.mpg. When making a copy to another 

computer, you need to remember to copy the entire folder Time lesson. If you do so you don’t have to 

copy and paste the new path for you video file whenever you use it on another computer. 



AsiaCALL Online Journal (ISSN 1936-9859) 2013 – Special Issue – AsiaCALL2012 Proceedings, Trần Thị Thơm 

 
 

 

 

    
 

 

 

 

                    
 

If  you want to load some videos on the same Window Media Player, you can make more labels and copy 

the command above, you just need to change the name of you root files on each command. For example: 

Private Sub Label1_Click() 

wmp.URL = ActivePresentation.Path + "\video\warm\kfc_1new.wmv" 

End Sub 

 

Private Sub Label2_Click() 

wmp.URL = ActivePresentation.Path + "\video\warm\kfc_2new.wmv" 

End Sub 

   

5.3. Using flash files 

Sometimes, teachers would like to use some flash files, so they need to do the following actions. First, 

on the Developer tab, in the Controls group, click More Controls  . In the list of controls, click 

Shockwave Flash Object, click OK, and then drag on the slide to draw the control. Second, right-click 

the Shockwave Flash Object, and then click Properties. On the Alphabetic tab, click the Movie 

property. In the value column (the blank cell next to Movie), type the full drive path, including the file 

name (for example, D:\time lesson\MEDIA\telling_time_gr2.swf). 

 

Another way is that you can install Swiff Point Player 2.0 software. After install that software, you only 

need to embed the flash file you want by doing the following steps: First, on Add-ins tab, click Flash 

Movie in Menu Commands group, locate the folder that contains the file, and then double-click the file 

that you want to add. If you are working with Microsoft Office PowerPoint 2003, on Insert tab, click 

Flash Movie, then locate the folder that contains the file. Finally, resize your flash files. 

 

5.4. Some other useful Macros and Commands in Visual Basic Editor 

5.4.1. Move a shape 

When you want to create a macro or a command, the first thing you need to remember is the order of the 

shapes you make on your slides sothat the macro will have an effect on the correct shapes. 

In order to move a shape to the left or the right, up or down on your slides, you can use the following 

macro: 

Label Command buttons 

Properties 
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a. Move to the left or the right 

   
 

Supposing that you would like to move the first shape on Slide 3 to the right 50 pixels, the shape Move 

needs to run the macro named move as follows 

 

Sub move() 

ActivePresentation.Slides(3).Shapes(1).IncrementLeft 50 

End Sub 

 

If you want to move this shape to the left 50 pixels, you change “50” to “- 50” 

Sub move() 

ActivePresentation.Slides(3).Shapes(1).IncrementLeft -50 

End Sub 

 

b. Move up or down 

 

If you want to move your shapes downwards 50 pixels, you have the following commands: 

Sub move() 

ActivePresentation.Slides(3).Shapes(1).IncrementTop 50 

End Sub 

 

In contrast, if you want to move your shapes upwards 50 pixels, use minus before 50 

Sub move() 

ActivePresentation.Slides(3).Shapes(1).IncrementTop -50 

End Sub 

 

5.4.2. Change the text of a shape 

In some games, you need to change the text of a shape in order to check the shape chosen already, or to 

introduce the new contents and so on. Therefore, you need to use a macro to do this. This macro can be 

applied when you let your class play Noughts and Crosses game. To win this game group X needs to have 

three  in a row before group O gets three  in a row and vice versa. In the game below, Group  

wins the game. 

            
 

After choosing question number 2, group  can answer it correctly, so the teacher click on  (X 

symbol) and then on the home slide, number 2 is changed into letter X.  

 

Sub MacroX2() 

ActivePresentation.Slides(1).Shapes(3).TextFrame.TextRange.Text = "X" 

Move  
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End Sub 

 

5.4.3. Set scores for groups 

In order to set scores for each group, teachers can create a macro, so students can see their scores on the 

presentation. It will make them feel more excited. 

 

 
Sub diem1000a() 

Dim a As Integer 

a = Val(ActivePresentation.Slides(2).Shapes(4).TextFrame.TextRange.Text) 

ActivePresentation.Slides(2).Shapes(4).TextFrame.TextRange.Text = a + 1000 

End Sub 

 

Although the text of a shape is a number, PowerPoint considers it a text. Therefore Val function is used to 

change a string into a number. It means that this number can function as a number itself. You can do the 

calculation with it.  With the command above, the score of each group will be added 1000 when you click 

on the flower. 

 

5.4.4. Hide or unhide a shape 

In memory games, one of their variations is hiding a shape, thus the following macro will help teachers to 

do this action. 

 

 
 

Sub bien1() 

ActivePresentation.Slides(4).Shapes(11).Visible = msoFalse 

End Sub 

The slide above is the fourth slide of the file, shape 11 is the hairbrush, when the teacher clicks number 1, 

the hair brush will disappear. If you want to unhide this picture change msoFalse to msoTrue 

 

Sub bien1() 

ActivePresentation.Slides(4).Shapes(11).Visible = msoTrue 

End Sub 

 

In this game, teachers click on a 

number to hide a picture, students 

have to guess what picture is missing. 
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6. Conclusion 

Although there are some limitation due to the lack of time, of my knowledge, of  my conditions for doing 

research, I hope that this paper might be beneficial for teachers in using multimedia to build good games 

in their English class. Also, teachers can make best use of multimedia in their entire teaching process so 

that students will be activated,  encouraged to learn English actively and enthusiastically. 
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